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Introduction

Story Maker is about making active animated speaking and 'sounding' stories - not just static pages that 
might as well be in a printed book.    You can make a story where figures move across the screen, appear 
and disappear, cause other things to happen, speak to you - you can do almost anything!

Playing stories is easy, just read and click and move from page to page.    If you want to know more about 
things you can do when playing read the section on Playing stories.

Making a story is pretty easy too.    You assemble pages using the backgrounds, picture stamps, animated
sprite stamps and speech bubbles.    As you become more experienced at making stories you can make 
the pages more interesting by making the stamps move across the page, disappear when you click on 
them or linking them together to so they react to each other.    If you want to know more about making 
your own stories read the section on Making stories.



Making Stories

A story is put together using several parts.    You get a selection of the parts by clicking on the buttons on 
the Story Maker screen.    In this section we will take you through the main parts of Story Maker so you 
can get started.

Click on this button to put a background picture on your page.    You will see some miniature versions of 
backgrounds.    At the bottom of the screen (and on many others) you will see a More button.    Click on 
this button to see more backgrounds.    Just click on one of the backgrounds to put it onto your page.

Click on this button to see the 'stamps' you can put onto your page.    A stamp is just a little picture - 
perhaps a person or a piece of furniture.    Just click on one of the stamps.    It will go onto the middle of 
your page.    You can move the stamp around by dragging it to where you want - just keep the mouse 
button down as you move the stamp.

If you go back to the stamp screen, there will probably be a More button, so you can see more stamps of 
the same type.    There will also be a Topics button.    Topics shows you the other types of stamps you 
can use.    Just click on one of the types to see stamps of a different sort.    There may be a More button 
on the Topics screen as well    (You will find More and Topics buttons on other Story Maker screens.)

Click here to see the sprites you can use.    Sprites look just like stamps.    But when you are playing a 
story sprites are very different.    A sprite is a little animated picture, which will change its shape when you 
click on it.    Click on one of the sprites to put it onto your page.    Then just drag it to where you want it.
If you want to move a stamp or sprite to a new position on your page, first click on the stamp or sprite.    
You will see a box around the figure.    The box shows that it is selected.    Now you can drag it to a new 
position.    As with stamps, sprites are divided into a number of topics.    Click on the Topics button to 
select a different range of sprites.

Click here to see the sounds you can use.    Seeing sounds is a bit odd!    So above each sound is an ear. 
If you click on the ear you will hear that sound (if your computer lets you hear it).

If you click on the name below the sound, then the sound goes onto your page.    You will see your mouse 
cursor change into a loudspeaker shape.    Any sound on your page has to be attached to a stamp or a 
sprite.    Move the loudspeaker cursor around without touching a mouse button.    As the cursor passes 
over the stamps and sprites on your page you will see a little box surround each one.    

When the loudspeaker is over the figure you want, click the mouse button.    The sound is now attached to
that figure.    You can't see any change, but when the page is played, clicking on that figure will make the 
sound.    So you can make cows moo, dogs bark or even make cars go meow!

Clicking here will pop a speech bubble onto your page.    You don't see a selection of bubbles, one is just 



popped into the middle of your page.    Now you can move the speech bubble to where you want by 
dragging it.

Of course a speech bubble is not much use unless it has some speech typed into it.    To type into a 

speech bubble, first click on it to select it. 
At the right-hand side of the screen you will see a new set of buttons appear.    Click on the one that says 
edit.    The speech bubble changes, and a typing cursor (a little flashing vertical line) appears in it.

Now you can type text into your speech bubble. 
 The bubble will automatically get deeper as you type.    When you have finished typing, either click back 
on the edit button (which will have changed to a button showing a speech bubble), or just click outside the
speech bubble.

You now know enough to get a great deal of fun out of Story Maker - even to make quite a complicated 
page.    If you want to make another page, you need to use the next page button.    This moves you on to 
the next page in your story.    If you are on the last page at the moment, it automatically gives you a blank 
new page for you to continue your tale.

Once you have put a few things on your page.    Select the Play button to try playing your story.

If you want to keep your story on disk to use again select the Save button.    You will be asked to give your
Story a name if it does not already have one.    When you come to continue the story later you use the 
Open button and select this name from the list.



Playing Stories 

You can play a story either by clicking on the Play button in Story Maker, or by starting up the Story 
Player module from Windows.    If you start up Story Player, you will be asked to pick a story to play 
before going on.

Try clicking on the various things you have on your screen.    Sprites will perform for you, and speech 
bubbles may read themselves to you.    If there are noises on stamps, they will squawk (or whatever) at 
you.

The cursor changes into a little hand when you pass over an item which does something on the play 
screen.    On the play screen, you just click on items - that is all you need to do.

There are only a few buttons on the playing screen.

If there is more than one page in a story, you can use the next page button, on the right-hand side of the 
screen, to move forwards a page (and the button next to it to move back).

In a long story, you can move to a particular page by clicking on this button.    You will be asked what page
you want to move to.

You may want to play your page again, as if you had just turned to it.    This button allows you to do this.    
When playing a story clicking on figures may make them move position.    Using this button makes 
everything return to where it started so you can play the page again.

All the stamps in Story Maker have names.    If you select this button, then you will see the names of the 
stamps as your cursor passes over them.    Click again to stop seeing the names.

Select this button to hear the names of the stamps as your cursor goes over them.    Click again to stop.    
(You can change the name of any stamp when you are making a story - see Rename.)

When you have finished playing, select the Stop button.    This takes you back to making your story.

There is only one menu on the play screen.    This contains less frequently used commands - see the Play
menu section for details of these.



Printing Stories 

When you have finished your story you might want to print it out for others to look at.    Story Maker 
always prints the pages exactly as they look when you are making you story - not when you are playing, 
so stories with lots of movement in them will just not be the same when printed out.    So if you are writing 
a story specifically for printing out, then avoid any animation, movement or linking.

Pages can be printed out in a number of different sizes.    By default Story Maker puts one page on each 
sheet of paper, printing as big as possible.    But you might want to save ink and print the pages smaller, 
maybe two pages per sheet.    The smallest size is 8 pages per sheet.    Alternatively you might be wanting
to produce a poster for the wall.    Story Maker can print one page on 4 sheets of paper ready to be stuck 
together afterwards.    You use the Choose print size command in the File menu to select different print 
out sizes.

To see how your story is going to be printed out use Print Preview.    This will show you how each page is 
placed on the paper.    Choose Close to return to making your story.

Story Maker stories can be printed on Colour or Black & White printers using any standard Windows 
printer driver.    When printing to black and white printers the colours are represented by shades of grey.    
Some black and white printer drivers will alter to colour of any text to be either black or white, depending 
on the brightness of the colour.    This can sometimes mean that the text of a speech bubble appears not 
to print, so if printing to a black and white printer check Print Preview first to ensure that your page will 
print as you want.



Opening and Saving Stories 

Completed and partly written Stories are kept on disk so they can be loaded again at a later date.    In 
addition to the stories you write, you will also find some example stories and some Story Starters - 
starting points for childrens own stories.

To fetch a story from the disk select the Open button.    You will see a list giving the names of stories 
already written.    If there are lots of stories you may need to scroll through the list to find the one you 
want.    They are shown in alphabetical order.    Alternatively you can type in the name.    If the name is a 
long one you can just type in the first few letters - just enough for the name to be different to all the others.

 When you select Open, the Stories button is selected - you will see the names of your own stories listed.  
If you want to see the Starter stories, choose the Starters button to see the list of Story starter files.    See 
Story Starters for more information on starters.    Click on Stories to go back to seeing your own stories.

Normally you can just see the stories in your current Story Maker directory.    But you might want to open 
a story from a different directory, floppy disk or network drive.    Clicking on Full store shows you a 
different Open dialogue box where you can choose different disks and directories in the standard 
Windows manner. Within the full store you can also choose to save your Story in a format suitable for 
earlier versions of StoryMaker.

To keep a Story to use again later you select the Save button.    If this is a new story you will be asked to 
give it a name, otherwise it will use the same name as before.    To give the story a different name you will 
need to use the Save as command in the File menu.



Example Stories, Hints and Starters

A number of example stories are supplied with Story Maker.    These are designed to show you what you 
can do with Story Maker, from simple stories through to quite complex operations.    It is worth having a 
good look at these before you write your own long masterpieces as they will give you ideas on how to 
make your story more interesting for others to read.

The examples can also be used as a reference aid.    If you are trying to make an object behave in a 
certain way and you are unsure how to do it then maybe an object in one of the examples does it already 
and by examining the settings on that object all will become clear (perhaps!).

Wizard Hints
We have also provided some examples that provide hints on how to achieve certain effects.    These are 
in the Wizard Hints and Wizard Links stories.    Before looking at these it is a good idea to be familiar 
with the way you write stories in Story Maker.    With the Wizard stories, first play a page to see the 
effects described.    Then go back to making the story and examine the settings for the stamps involved.    
The Visibility and Actions options are normally the most important.

Story Starters
Story starters are stories that may give children a starting idea for a story.    They may just be a page or so
of ideas, or a story line to get children going.    You can add your own Starters to the ones supplied.    After
selecting Save as from the File menu, select the Starters button before saving your own story.



Troubleshooting your stories

What do you do if your story doesn't work the way you expect it to?

Many problems arise when linking stamps together.    Make sure you are familiar with how linking works - 
if necessary look at the Wizard Links story.    This shows you how to achieve certain effects.    Check that 
you have set up your objects in the same way in order to achieve the same effect.

Linking is a bit like programming, every action follows on from a previous action in a logical fashion, so a 
logical approach to tracing the problem is helpful.    Follow the sequence of events through checking that 
all is as it should be.    You may find it helpful to write down what each object is supposed to do.

The Show links command from the Stamps menu is useful for discovering where your page is going 
wrong.    Check that the objects are linked in the order you expect.

Try and isolate the problem.    If the problem occurs in the middle of some long chain of linked events, 
temporarily ensure you can click on one of the objects in the middle of the chain so you don't have to start
from the beginning each time.    This makes it quicker to find the cause of the problem, and can show up 
problems caused by actions earlier in the chain.    For example you might be linking to the same object 
twice.

If you are still stuck, try asking a friend who is familiar with Story Maker.    Explain to them what you are 
trying to do and how you are going about it.    Just talking about it can sometimes make you realise what 
you are doing wrong.

SPA is happy to help with problems with Story Maker stories.    Experience has shown that trying to solve 
them by telephone is not successful as the cause is likely to be an obscure interaction between objects.    
And by the time you come to us you have probably tried all the obvious answers.    So post us the story on
a disk or send it to us by Email. Please just send the page with the problem on.    Explain to us clearly 
what the problem is and we will try to help.    Select About Story Maker from the File menu for details of 
SPAs postal and Email addresses.    Please also include the version number of Story Maker and software
licence number.



Cutting and Pasting

You can use the Cut, Copy and Paste commands to copy Story Maker objects and text.    You can do a 
number of different things.

Firstly using Copy and then Paste allows you to make copies of a stamp, a sprite, or a speech bubble on 
your page - or to produce a copy on another page.    This might be quicker than finding a particular stamp,
say,    by clicking on the stamp button.

For example, to copy several objects from your current page to a new one, hold down the shift or Ctrl key,
and click on each of the objects in turn.    You will select them each one by one.    Then select Copy.    Now
move to your new page and select Paste.    The selected objects will all be pasted onto your new page.    
Copied objects have the same options as the objects they were copied from, but any links between 
objects are lost and you will need to set them up again on the new page should you wish to keep them.

You can also copy a stamp and then paste it into any other Windows program.    So you can (for example)
copy the Princess, start up your favourite Windows painting program, paste her in, and change the colour 
of her clothes - or add another head.    When you have finished, just copy the newly clothed princess in 
your painting package, swap back to Story Maker and paste her back again onto your page.    (Note that 
you can only paste stamps back onto a Story Maker page, not into the libraries of stamps.)    For more 
information on doing this see Extending the stamps.

You can also copy and paste text in speech bubbles - so you can paste text from a Windows application 
into a Story Maker speech bubble if you wish - see Extending the text.    And you can paste copies of 
sounds from Windows applications as well - see Extending the sounds.



Extending Story Maker

Story Maker comes with a host of stamps, sprites, sounds and backgrounds.    But there are bound to be 
things you want in a story that we don't supply.    Click on the appropriate topic below to find out how to go
about changing and adding to the Story Maker resources

Extending Topics:

Backgrounds
Stamps
Sounds
Speech
Text



Extending the Backgrounds

You can easily add background pictures of your own to appear alongside the Story Maker ones when 
you click on the Background button.    Background pictures must be in either .BMP or .PNT (PaintSpa 
Plus) format.    The backgrounds we supply are 536 pixels wide by 380 pixels deep.    

If you use backgrounds larger than the window available for them, then just the centre section will be 
used by Story Maker.

To make backgrounds of your own to appear alongside the supplied ones, you must keep them in the 
same directory as our background pictures.    This is a sub-directory of the story directory called 
backgrnd.    On stand-alone computers this is normally c:\story\backgrnd.



Extending the Stamps:
Adding your own and Editing ours

Editing Story Maker stamps is simple.    First put the stamp you want to change onto a page of your story.
Make sure it is selected, and then select Copy (in the Edit menu).

Now start up your favourite Windows painting application (such as Windows Paint).    Paste the stamp into
it.    You can now modify the stamp as you wish (such as changing colours of clothes etc).    When you 
have finished, select your modified stamp, with as little of the background as possible.    Select Copy and 
go back to Story Maker. Select Paste in the Edit menu, and your modified stamp will appear on your 
page.    (In fact, Windows Paint is not very good about preserving Stamp colours.    If you experience 
difficulties it may be better to use an alternative painting program).

Adding your own stamps to a story is also easy.    You can simply copy any picture you want from a 
suitable Windows package and paste it straight into a Story Maker page.

Note that any pure white in a stamp is the 'see-through' colour in Story Maker.    If you want part of your 
stamp to be white, then you must use the lightest grey that you have available instead of pure white.

The Story Maker libraries of stamps are held in a special format, so the only way of adding to or 
amending them is to use the Stamp Library Builder program supplied with Story Maker.    With the 
Stamp Library Builder you can create new stamp and sprite libraries - full instructions are given in the help
for that program.

Additional libraries of stamps are available from SPA.    Details are on the Story Maker page of our Web 
site - or send for more details.



Extending the Sounds

You can add sounds to the supplied ones.    Sounds are stored by default in sub-directories of c:\
story\soundfx.    So, for example, animal sounds are in c:\story\soundfx\animals.    Note that 
the sounds supplied with Story Maker are provided for use only in connection with making Story Maker 
stories.    However tempting, you may not copy or use them for any other purpose.

While it is great fun getting out your own coconuts to make galloping horse effects, you will be able to find
extra sound effects that you can use without breach of copyright by searching the almost infinite 
resources of the World Wide Web.

Some of the sound effects that come with Story Maker are shareware, supplied by Speyside Software 
Enterprises, 11 Sellar Place, Aberlour on Spey AB38 9LE.    Further sounds (on their Waves disks) may 
be obtained from them.    

If you do obtain further sounds, you may wish to create a new sub-directory of c:\story\soundfx in 
which to put them.

Note that any sounds you add to Story Maker may be stereo or mono, and be in any of the standard 
Windows WAV formats.    However, not all computers support all sound formats.    If you experience 
difficulty with some sounds convert them to the standard PCM    .WAV format using a suitable sound 
processor.

Note that you can also copy a sound in a sound processor.    If you then select Paste in Story Maker, you
will get the loudspeaker cursor shown.    You can then put the sound onto a stamp just as if it had come 
from Story Maker's library of sounds.



Extending the Speech

Story Maker comes with 20 different types of voices.    You can choose which of these to use for speaking 
a particular speech bubble by selecting the Speech button.    As supplied, voice number 1 is allocated to 
Man, voice number 3 to Woman, and voice number 4 to Child.    If you want to change which voice 
number corresponds to each of these, first decide which voice number you want to use for each.    Then 
make the changes you want using the Voices item in Preferences in File.

You can teach the speech synthesizer new pronunciations using the Speech Editor program supplied 
with Story Maker.    Full instructions are provided in the help for that program.

If you wish, you can record speech and use this when a speech bubble is spoken instead of the speech 
synthesizer.    You either use the Record button in the Speech options or record the voice using your 
favourite Sound Processor.    Your recording should be in .WAV format.    Use the Speech button to select 
which .WAV file you want spoken when the appropriate speech bubble is played.



Extending the Text

Note that instead of typing text directly into a speech bubble, you can copy text from any Windows word 
processor (or other application), and then Paste that into a Story Maker speech bubble. 



Giving your stories away

Naturally when you have finished your masterpiece you will want other people to be able to play it. The 
best way to make stories available to lots of people is through the Internet.    Alternatively you can send 
them on disk to your friends.    Remember that to play a story, your friends need a copy of the Story Player
program.    You may freely send them copies of the Story Player disk - but not Story Maker itself.    
Alternatively, the Story Player program may be downloaded from our web site at www.spasoft.co.uk.

Publishing Stories on the internet
Sending a Story to a friend
Distributing the Story Player program
Parts of a Story Maker story
Story Maker versions



Publishing stories on the Internet

The best way to make stories available to lots of people is through the Internet.    We have reserved space
on our Web site for Story Maker stories.    They are available for anyone to download free of charge.    If 
you send us a copy of a story, we will see if we can find space for it on the site.    You can send it on disk 
or email it to us.    Our site is at www.spasoft.co.uk.    Stories will be found on the demonstration 
pages.

Alternatively you can put stories on your own web-site for other users to download.    Users will need to 
obtain a copy of the Story Player program which can be downloaded from our own Web site.    If you put 
stories on your own site, please tell us and we will include a link from our site to yours.



Sending a story to a friend

Simply keep the Story on a floppy disk.    Unless you have recorded a voice file to use as speech, the only
file you need to give them is the Story itself.    Of course they will also need a copy of the Story Player 
program (unless they have purchased Story Maker itself).

However, It is quite easy to make stories that will not fit on a single floppy disk.    This may not be a 
problem if you have (say) a Zip disk, or other large capacity removable disk drive.    Another method of 
giving away big stories is to send them to your friends as an email attachment over the Internet.    
Alternatively a compression program such as PKZIP may reduce your story to a more manageable size.

If none of these possibilities is open to you, you will have to split your story up.    Simply load your story 
into Story Maker, delete (say) the second half and then Save it with a different name.    Then load the 
original story again, delete the first half and save again with a different name.    You may then be able to fit
the story onto two disks.    (Of course, if your story is huge, you may need to split it into more than two 
parts.)

If the person receiving your story has purchased a copy of the full    Story Maker package, then they will 
be able to use the Merge command in the File menu to join your story bits together again.    If they just 
have Story Player, then they will have to play the bits separately.



Distributing the Story Player program

In order for someone to read a story, they need a copy of Story Player installed on their computer.    
Story Player can be downloaded from the demonstration pages on our Web site at 
www.spasoft.co.uk.    Alternatively, Story Player comes on a separate disk in the Story Maker 
package.    You may allow the contents of the Story Player disk to be freely copied - so you can give the 
disk (or a copy of it) to someone else so they can install it on their machine.

You may only allow the Story Player disk to be copied.    No other part of the Story Maker package 
may be copied.

Note that to work properly, the Story Player disk must be installed following the screen instructions.



Parts of a Story Maker story

When you save a story, all the stamps, sprites, sounds etc. are saved in the story, so all you need to give 
someone is the .STF file.    However, if you have recorded your own speech to be used by a speech 
bubble, this is not saved with the story.    If you want to send your story to someone else, note that you will
need to send your speech recording as well.

When keeping a Story Maker story you can give it a long descriptive name.    However, these names are 
not the same as the long Windows 95 filenames, so if you view the files in Windows 95 Explorer you will 
just see an 8 letter name.    This enables the files to be compatible with Windows 3.1

To find out the filename that corresponds to the Story Maker long name use the Full Store button in the 
Open Story dialogue box.    If you click once on the long name in the list, the exact filename will be shown
in black above the list of names.

The file extension used by Story Maker for its stories is STF.    For details of other file extensions used 
with Story Maker see Story Maker files and file extensions.



Story Maker versions

This version of Story Maker contains features not included in previous versions.    This includes the "Link 
to page" command and the ability to play sounds in different WAV formats.

To save a story that can be used by Story Maker version 1.0 you use the Type list in the Save As 
dialogue box.    Choose the appropriate format.    When saving in a format for an earlier version you will be
warned if features are used that will not be available in that earlier version.



Story Maker files and file extensions

In addition to the Story Maker and Story Player executable files there are a number of other files used 
by Story Maker.    These contain the Stamp and Sprite libraries, the backgrounds etc.    Below is a 
description of these together with appropriate file extensions.    This will enable you to remove any files 
you don't need.

Stamp Libraries:    File extension .ILB
These are located in the Story directory.    Each library file represents one topic.    An index file 
STORYILB.STY is created the first time you use Story Maker or whenever you add, change or remove a 
stamp library.

Sprite Libraries:    File extension .SLB
These are located in the Story directory.    Each library file represents one topic.    An index file 
STORYSLB.STY is created the first time you use Story Maker or whenever you add, change or remove a
sprite library.

Backgrounds:    File extensions .PNT or .BMP
These are located in a sub-directory of the Story directory called BACKGRND.    The files can be in 
PaintSpa Plus (.PNT) or Windows (.BMP) picture format.    An index file STORYSCE.STY is created the 
first time you use Story Maker or whenever you add, change or remove a background.

Sounds: File extension .WAV
The sound effects are located in a sub-directory of the Story directory called SOUNDFX.    They are then 
further sub-divided into more sub-directories, each directory representing a single topic.

Note that the sounds supplied with Story Maker are provided for use only in connection with making Story
Maker stories.    However tempting, you may not copy or use them for any other purpose.

Stories:    File extension .STF
By default the Story files are saved in the Story directory.    For more information on Story Maker story 
files see Parts of a Story Maker Story.

Story Starters:    File extension .STF
Story starter files are normal Story Maker stories kept in a special directory called STARTERS.

Story Maker Configuration Files:    File extension .INI
Separate configuration files are used by the Story Maker (STORYM,INI) and Story Player (STORYP.INI)
programs.    These are kept in the WINDOWS directory.

Spell Checker:
The spell checker consists of a support file (SPASPELL.DLL)    and directory (SPASPELL) containing the 
dictionaries.    These are located in the WINDOWS\SYSTEM directory and may be shared by more than 
one SPA Windows application.

Speech Synthesis:
The speech synthesis files consist of a support file (JSDSPCH.DLL) and a directory (JSDSPCH) 
containing the voice and pronunciation information.    These are located in the WINDOWS\SYSTEM 
directory.    These files may be shared by more than one application.



Toolbar - Making a Story

    Starts a new story

      Opens a story

    Saves a story

 Saves a story

 Cuts an object or text

    Copies an object or text

    Pastes an object or text

    Load a background

    Add a picture stamp

    Add a sprite

    Add a speech bubble

    Add a sound

    Move object to the back

    Move object to the front



    Move back one page

    Move forward one page

When playing a story a Playing toolbar is shown.



Toolbar - Playing a Story

    Stops playing the story

    Replays the current page

    Show the stamp names

    Speak the stamp names

When playing a story a Making toolbar is shown.



The Stamp and Sprite tools

If you have a stamp or sprite selected then buttons at the right hand side become active.    For more 
information on a particular tool click on the appropriate button below.

    Makes the object smaller in pre-defined steps

    Makes the object bigger in pre-defined steps

    Flips (reflects) the object

    Plays any sound the object has

    Records a path for the object to move along

    Shows the object moving if it has a path

    Links the object with another object

    Breaks a link if one has been made

    Set duration of sound

    Set when you can see the object

    Set movement and linking options

    Drag unwanted objects into the dustbin



The Speech Bubble tools

If you have a speech bubble selected then appropriate buttons at the right hand side become active.    For
more information on a particular tool click on the appropriate button below.

    Lets you put text into the bubble or change the text

    Makes the speech bubble narrower in pre-defined steps

    Makes the speech bubble wider in pre-defined steps

    Speaks the speech in the bubble

    Removes (or adds) a spike to the bubble

    Records a path for the bubble to move along

    Shows the bubble moving if it has a path

    Links the bubble with another object

    Breaks a link if one has been made

    Set how the words are spoken

    Set when you can see the speech bubble

    Set movement and linking options

    Drag unwanted speech bubbles into the dustbin



The Text Editing tools

If you are editing the text of a speech bubble selected then appropriate buttons at the right hand side 
become active.    For more information on a particular tool click on the appropriate button below.

    Stop editing

    Makes the speech bubble narrower in pre-defined steps

    Makes the speech bubble wider in pre-defined steps

    Makes the letters smaller

    Makes the letters bigger

    Changes to a different font

    Justifies the text differently

    Changes the colour of the letters

    Changes the background colour of the text



The Spell checker tools

If you are checking the spelling of your page then appropriate buttons at the right hand side become 
active.    For more information on a particular tool click on the appropriate button below.

    Find the next mis-spelt word

    Ignores the mis-spelling

    Stop checking the spelling

    Replaces the word with the correct spelling



File menu commands

The File menu offers the following commands:

New Starts a new story.
Open Opens an existing story.
Merge Adds another story to your current one.
Save Saves your current story.
Save As Saves your current story with a new name.
Print Prints your story.
Print Preview Displays your story on the screen as it would appear printed.
Choose print size Gives you the choice of printing your story in different sizes.
Printer Setup Selects a printer and printer connection.
Preferences Takes you to another menu where you can configure various options 

about Story Maker.
Exit Exits Story Maker.

Preferences menu commands

The Preferences menu offers the following commands:

Keep Settings Lets you save the options as they are currently set up for Story Maker.
Advanced 
Tools

Gives you more tools to use.

Dictionary Lets you choose between the Beginner's and the Advanced dictionaries.
Recording 
Speed

Lets you choose the speed at which paths are recorded.

Resize stories 
to Window

Lets you choose whether the pages of the story are expanded to fit the window.

Sizing Bobbles Lets you chooses how you can resize objects.
Voices Lets you configure the default voices.



Edit menu commands

The Edit menu offers the following commands:

Undo Undoes the last change on your page.
Redo Undoes the last undo.
Cut Deletes an object from the page and moves it to the clipboard.
Copy Copies an object from the page to the clipboard.
Paste Pastes from the clipboard into the document.
Group as one Allows you to group several objects together.
Ungroup Ungroups a group of objects.
Check spelling Lets you check the spelling for your current page.



Stamps menu commands

The Stamps menu offers the following commands:

Show names Allows you to see the names of the stamps and sprites.
Speak names Allows you to hear the names of the stamps and sprites.
Show links Shows all the links on the page.
Playback speed Lets you change how quickly an object moves along its path 
Rename Lets you to change the name of a stamp 
Insert name Inserts the name of a stamp or sprite into a speech bubble
Remove sound Lets you take off a sound from an object 
Remove path Lets you take off a path from an object.
Link to page Link an object to a different page,

Page menu commands

The Page menu offers the following commands.

Previous page Moves you to the previous page of your story.
Next page Moves to the next page of your story.
First page Moves to the first page of your story.
Last page Moves to the last page of your story.
Go to page Moves to a specific page of your story
Insert page Lets you insert a single page.
Delete page Deletes your current page
Play page Lets you play your current page
Play story Takes you to page 1 and plays that page.



Play menu commands

The Play menu offers the following commands.

Stop playing story Takes you back to making your story.
Previous page Moves you to the previous page of your story.
Next page Moves to the next page of your story.
Go to page Moves to a specific page of your story
Replay page Starts playing this page again.
Sound Controls whether the computer makes noises
Automatic page turning Set to automatically move to next page after a set time
Set turning speed Sets the speed at which pages turn.



Help menu commands

The Help menu offers the following commands, which provide you assistance with Story Maker: 

Index Offers you an index to topics on which you can get help.
Using 
Help

Provides general instructions on using help.

About Displays the version number of Story Maker.

Backgrounds

Clicking on the background button shows you the available backgrounds in miniature. At the bottom of the
screen you will see a More button.    Click on this button to see more backgrounds. 

Just click on one of the backgrounds to put it onto your page.

You can also have a plain coloured background if you prefer.    Just select the button and you will see the 
choices of colour available.    On higher resolution screens, selecting a plain background first, and then 
going back and selecting a background picture enables you to show the picture on your coloured 
background.

The background may be shown at the size it was drawn at or it may be enlarged or reduced to fit the 
window it is displayed in.    The section on Resize stories to Window has more information on this.

You can add additional backgrounds of your own if you want.    See Extending the backgrounds.



 Stamps

Clicking on the Stamp button shows you the stamps available on a particular topic.    There may be a 
More button at the bottom of the screen.    Click on that to see other stamps on that topic.

There will also be a Topic button.    Clicking on this shows the other stamp topics available.    Just click on 
the topic you want. A few especially useful stamps appear in more than one topic, but generally you will 
just have to remember that you only find barbecues when Camping and that the Pirates have captured 
the treasure chest.

Click on the stamp you want, and it will be put into the centre of your page.    You will see a box round it, 
telling you that it is selected.    You can now drag it (or move it with the cursor keys) to where you want.    

The stamp may have 'bobbles' at its corners.    If it does, you can drag on these to change the size of the 
stamp.    You turn bobbles on or off by selecting Sizing bobbles in Preferences in the File menu.

When you have a Stamp selected the tools at the right hand side become active.    See Stamp and Sprite 
Tools for how to change your stamp.

To select the stamp again at a later time just click on it.    You can also select more than one stamp.    See 
Selecting and Grouping objects for more details.

When you have lots of things on your page you may wish to move one behind another.    You do this using
the move to back and move to front buttons at the top of the screen.    Stamps that move when they play 
always come to the front to move.



 Sprites

Clicking on the Sprite button shows you the sprites available on a particular topic. Sprites look just like 
stamps.    But when you are playing a story sprites are very different.    A sprite is a little animated picture, 
which will change its shape      There may be a More button at the bottom of the screen.    Click on that to 
see other sprites on that topic.

There may also be a Topic button.    Clicking on this shows the other sprite topics available.    Just click on
the topic you want.

Click on the stamp you want, and it will be put into the centre of your page.    You will see a box round it, 
telling you that it is selected.    You can now drag it (or move it with the cursor keys) to where you want.    

The stamp may have 'bobbles' at its corners.    If it does, you can drag on these to change the size of the 
stamp.    You turn bobbles on or off by selecting Sizing bobbles in Preferences in the File menu.

When you have a Sprite selected the tools at the right hand side become active.    See Stamp and Sprite 
Tools for how to change your sprite.

To select the stamp again at a later time just click on it.    You can also select more than one stamp.    See 
Selecting and Grouping objects for more details.

 When you have lots of things on your page you may wish to move one behind another.    You do this 
using the move to back and    move to front buttons at the top of the screen.    Sprites always come to the 
front when moving.



Speech bubbles

When you click on the speech bubble button at the top of the screen a speech bubble is popped onto the 
centre of your screen.    Any text that you want on your page has to go in a speech bubble - but these are 
very flexible as we shall see.    After putting your bubble on the page, you can now move it to where you 
want.    You can also move the 'spike' around the outside of the bubble by dragging inside the spike, or 
change the position of the end of the spike by dragging.

When you have a Speech bubble selected the tools at the right hand side become active.    You can use 
these to change the way speech bubble and text within it looks.

 To type into a speech bubble click on the tool on the right hand side that says edit (or double click on the 
bubble).    The speech bubble changes and a typing cursor appears.    Now you can type text into your 
speech bubble.    The bubble will automatically get deeper as you type.    To change the width of your 

bubble use the wider  and narrower 

 buttons, or use the resizing bobbles if you can see them. 

When you have finished typing either click back on the edit button    (which will have changed to a button 
showing a speech bubble) or just click outside the speech bubble.

If you want to put a piece of narrative text on your page (perhaps a few lines at the bottom of the page), 
you can use speech bubbles to do this.    You can remove the spike and the bubble will grow with your text
to be as big as you want.    You can change the width of your speech bubble either by dragging on the 
bobbles (if you can see them) or using the change size buttons on the right of the screen.

See Speech bubble tools for details on how to change the text in other ways.



 Move to front

Click on this button to bring the selected object(s) to the front of your page.    You may need to do this to 
make sure that objects sit properly together i.e. a rider sitting on the horse (rather than a rider hiding 
behind a horse!).    It can also be used where objects overlap to ensure that the correct one is clicked on 
when playing the page.



 Move to back

Click on this button to send the selected object(s) into the background of your page, behind all the other 
objects.    You may need to do this to make sure that objects sit properly together i.e. a horse needs to be 
behind its rider, rather than a rider hiding behind a horse.    It can also be used where objects overlap to 
ensure that the correct one is clicked on when playing the page.

Remember that any when playing, moving objects always come to the front.



Selecting and Grouping objects

To select a stamp, sprite or speech bubble you just click on it. (If you want to select an object that is 
completely covered by another, click with the Alt key held down.)    You can also select more than one 
object by clicking with the shift or Ctrl key held down - or by dragging over all the objects you want to 
select with your mouse button held down.

If you want to select several objects quite often, you can group objects together.    First select the things 
you want to group (stamps, sprites and speech bubbles can all be mixed in a group) and then click on 
Group as one in the Edit menu.    Notice that the selection rectangle for a sprite is usually bigger than the
sprite appears.    This is because the rectangle is the size of the largest 'frame' of the sprite.

While your stamp or sprite is selected, you will see other buttons appear at the right-hand side of the 
screen.    Note that you must have selected an object before these buttons become active.



 Sounds

Clicking on this button shows you sounds you can use. 
 Seeing sounds is a bit odd!    So above each sound is an ear. If you click on the ear you will hear that 
sound (if your computer lets you hear it).    The sounds are divided into topics of similar sounds.    If there 

is a More you can click on it to see other sounds in the same topic.    
 To see sounds in a different topic click on the  button and a list of different topics will be shown, from 
which you can choose.

When you have found the sound you want, click on the name below the ear, and the sound will go onto 

your page.    
 You will see your mouse cursor change into a loudspeaker shape.    Any sound on your page has to be 
attached to a stamp or a sprite.    Move the loudspeaker cursor around without touching a mouse button.    
As the cursor passes over the stamps and sprites on your page you will see a little box surround each 
one.    

When the loudspeaker is over the figure you want, click the mouse button.    The sound is now attached to
that figure.    You can't see any change, but when the page is played, clicking on that figure will make the 
sound.    So you can make cows moo, dogs bark or even make cars go meow!

To change the sound attached to a stamp or sprite simply place another sound on it, or to remove a 
sound select Remove sound from the Stamps menu.

You can also add sounds to stamps and sprites by cutting and pasting them from other applications.    
When you paste a sound into Story Maker the cursor changes to the loudspeaker shape as if you had 
selected it from Story Maker's provided sounds.    You can also add your own sounds to the Story Maker 
sound topics.    See of Extending the sounds for more information on adding your own sounds.

Note that the sounds supplied with Story Maker are provided for use only in connection with making 
Story Maker stories.    However tempting, you may not copy or use them for any other purpose.



 Make object smaller

Click on this button to make the object smaller in pre-defined steps.    The object is always resized in 
proportion (i.e. its aspect ratio is preserved).

There are seven different pre-defined sizes.    When the object cannot be made any smaller then this 
button is dimmed.

You can also change the size of objects using the resizing bobbles that may appear at the corners of the 
box that is drawn around the selected object. You turn bobbles on or off by selecting Sizing bobbles in 
Preferences in the File menu. 



 Make object bigger

Click on this button to make the object bigger in pre-defined steps.    The object is always resized in 
proportion (i.e. its aspect ratio is preserved).

There are seven different pre-defined sizes.    When the object cannot be made any bigger then this 
button is dimmed.

You can also change the size of objects using the resizing bobbles that may appear at the corners of the 
box that is drawn around the selected object. You turn bobbles on or off by selecting Sizing bobbles in 
Preferences in the File menu.



 Flip object

Click on this button to flip (reflect) the object.

Objects can only be flipped horizontally (with a vertical mirror line)



 Listen to object

Click on this button to hear any sound the object has.

With a stamp or sprite the sound will be any sound effect that has been placed on the object.    The sound 
will only be played once.    You can choose how many times it is repeated when playing the page using 
the Sound button.

With a speech bubble the sound will be synthesized speech.    You can choose a different speaking voice 
using the Speech button.



Paths

The two buttons below allow you to record the movement of an object along a path, and to view the object
moving along the path.    Any stamp, sprite or speech bubble can have a path associated with it.    

First select the object you want to move, then click on the video camera button.    Now drag your selected 
object along the path you want it to have.    When the path is complete just let go of the mouse button.

To see whether your path is exactly as you wished, make sure the object is selected and then press the 
little TV button.    Sprites will animate as they go along their path.    Stamps and speech bubbles simply 
move.

If you want a sprite to animate itself in the same spot several times, then you might want simply to record 
a path for the sprite that doesn't go anywhere, but lasts as long as you want.    So instead of dragging the 
sprite along a path, just keep it in the same place when you are recording its 'path'.    When you play the 
path you will see the sprite go through its actions on the spot for as long as you recorded it.

Using the advanced Actions and Visibility tools you can control how and when the object moves when 
playing your story.    For example you can make your object move continuously whenever you turn to the 
page it is on.

You can also make individual objects move faster or slower than you recorded them using Playback 
speed in the Stamps menu.

If you want you can also change the number of frames per second that are used when recording your 
path.    Recording at a faster speed can make the movement smoother.    See Recording speed for more 
details.



 Linking

These two buttons are perhaps the most powerful in Story Maker.    They allow you to link one object to 
another.    Linking is simple to do, but you must remember that all links have a direction.

    For example, suppose you have the Farmer's wife stamp and the chicken sprite on your page.

To link from the Farmer's wife to the chicken, first select the Farmer's wife.

 Now click on the Link button on the right-hand panel.    You will see a linking line spring out from the 
Farmer's wife with a little link cursor at its end.    An arrowhead shows you which way the link will go.

 As you move the link cursor over the page, rectangles appear round objects.    This helps you see exactly
which object your cursor is over.    When the cursor is over the chicken (so the chicken has its rectangle 
showing) click your mouse button.    There is now a link from the Farmer's wife to the chicken.

What does this mean?    To find out, you will need to click on the Play button to play the page. 

 When you are playing the page, and you click on the Farmer's wife, a signal travels along the link to the 
chicken, which will also think it has been clicked on.    Since the chicken is a sprite, when it is clicked it will
start pecking.    So clicking on the Farmer's wife will now make the chicken peck.    If you attach a sound to
the chicken, then the chicken will peck and make its sound as well.

You could also set up a link from the chicken to (say) a flapping vulture.    Then when you click on the 
Farmer's wife, the chicken will peck and the vulture will flap.

An object can only be linked to one other object.    Having made a link from the Farmer's wife to the 
chicken you cannot link her directly to anything else.    (However, there is nothing stopping you linking 
back from the chicken to the Farmer's wife if you want to.)



 But for example, you might want the Farmer's wife to speak Here chukkie when you click on her, and the 
chicken to peck.    To do this first place the speech bubble; then link the Farmer's wife to the speech 
bubble, and then link the speech bubble to the chicken.

As links can quickly get very complicated, you can Show links in the Stamps menu to see all the links on
your page.

This describes the simplest use of linking, but you can do far more adventurous things.    You can use the 
Sound, Visibility and Actions buttons to control objects and linking with more precision.    

You can also link objects to specific pages, so when you click on an object StoryMaker turns to a page 
you give it and carries on from there.    Using this facility you can create branching or adventure style 
books.    See Link to Page for information on how to do this.

You will also find some Hint stories supplied with Story Maker which will help you make interesting effects
of your own - see Story Starters, Examples and Hints.



 Deleting objects

To delete unwanted objects simply drag them onto the dustbin.    

As the cursor moves over the dustbin it changes to a dustbin shape.    When it is this shape let go and the 
object will be removed from your page.    If you change you mind after deleting an object, select Undo 
from the Stamps menu to put it back.

You can also press the Del or Delete keys when an object is selected to delete an unwanted object.



Sound options

Click on the Sound button to change the duration that a sound attached to an object is played for. You will
be given a number of choices:

Play sound once
Select this if you want the sound played just once.

Play [ ] times
Select this if you want the sound to be played a specific number of times.    Type in how many times the 
sound should be repeated.    You might wish to do this if you have (for example) a telephone stamp on 
your page and you wish the phone to ring six times.

Play continuously when moving
Select this if you want the sound to be repeated all the time that the stamp or sprite is moving.    Perhaps 
a siren to accompany a moving fire-engine.

Computers can generally only play one sound at a time.    So if an object with a sound attached is linked 
to another object with a sound attached, the link will only be followed after the sound of the first object is 
finished.    Also, clicking on an object which has a sound will interrupt any other sound being played.

Although you set the duration when making your story, the effect can only be seen when playing the story.



Speech options

Click on the Speech button to change how the text is to be spoken.    You will be given a number of 
choices.    You can use the Listen button to hear the effect of any changes you make.

Not spoken
Select this if you do not want the text in this bubble spoken at all.

Use speech synthesizer
Select this if you do want the bubble spoken to you.    You can then choose which voice to use:

Man Select this for the voice of a man.
Woman Select this for the voice of a woman
Child Select this for the voice of a child
Other Select this for a different voice (see below)

Use sound file
Select this to have a real voice speaking the text.    If you have already recorded the speech then type the 
name of the file (which should be a Windows .WAV file) or use the browse button to find it on your disk.    
If not then use the Record button to record your speech.
If you give your story to somebody else you will need to give them these speaking sound files too.

Voices
There are 20 different voices provided, giving a range of styles and accents.    There is a page in the 
Wizard Hints story that enables you to hear them all.    Or you can just type in a number between 1 and 
20 in this dialogue box.    Voice 0 is a special voice to be used on slower computers if you find that the 
speech pauses in mid sentence frequently.    The voices chosen for Man, Woman and Child are standard, 
unaccented voices.    To change the voices generally used for these, select Voices from Preferences in 
the File menu.



Record speech

You use the Record dialogue box to record speech from a microphone or other input device such as a 
tape recorder.

Click on the Record button when you are ready to begin.    The time bar shows how long the recording is 
in seconds.    When you have finished recording click on the Stop button.

To listen to your recording click on Play.

If you don't like the recording then use Record to try again.    To change the quality of the recording click 
on Quality.    Then you can select between Mono and Stereo and 3 different qualities.    The better the 
quality, the larger will be the data file on the disk that contains recording.    The size of the recording in 
bytes is shown beneath the time bar.

When you are happy with the recording use the Save or Save As buttons to keep the recording in a data 
file.    Normally Story Maker will give the file a meaningless name such as "story001.wav" - use Save As 
to give it a more meaningful name.    The name can only be 8 characters long and should have the file 
extension ".wav".

Story Maker will only record uncompressed sound.    To record using compression or to have more 
options for editing and manipulating the recording you will need to use a sound processor such as 
Goldwave.



Recording Quality

Choose from 3 different recording qualities:    telephone, radio and CD.

Choose either Mono or Stereo recording.

The actual format definition in Hertz and bits is displayed when you change the selection, together with 
the size of data needed to record one second.    The better the quality, the larger the size of the data file 
needed.



Visibility options

Click on the Visibility button to choose when the player will be able to see the objects on your page.

Many objects on your page will have three phases.
1 Before being selected

The initial phase - how you see them when you first turn to the page.

2 When moving/speaking 
The action phase - when they are moving, or the text in them is being read, or the sound attached 
to them is being made.

3 When action completed
The final phase - how you see them when they have completed their action.

Using the choices on the Visibility panel you can make any object visible or invisible to the player in any of
the three phases.

If an object has no action - for example a stamp that just sits there on your page - then it does not have 
an action phase.    The choice of (in)visibility for the action phase will be dimmed for this type of object.

Can click on when invisible
Select this option if you want the player to be able to select an object that is initially invisible.    You might 
wish to do this if your page includes a hide and seek element.    If this option is selected then the arrow 
cursor will change to a hand as the player moves over the (invisible) object.

To see the effect of your choices about Visibility, select the Play button



Actions options

Click on the Actions button to control the action of your object - and when the next action should start if 
your object is linked to another.

Note that an 'action' can be 
an object moving along its path
a sprite (without a movement path) animating itself once
the text in a speech bubble being read
an object playing its attached sound

Begin Action:
When object is selected
Object will start its action when it is selected, either by clicking or by a link.

Only by means of a link
If there is a link to this object, its action will start only when the link is activated.    The object cannot 
be clicked on to start its action.    This is useful to prevent the player starting a sequence of events 
in the middle.

When page is turned to
Object will start its action immediately you turn to this page.    You might wish to do this to play the 
page automatically, without the need for any input from the player, or to start sprites such as 
glistening suns or to read some narrative text of the story.

Follow movement path:
If the action of the object is to move then you can choose where it stops (if at all)

To end of path and stop
The object will move to the end of its path and stop there.

To end of path and return to start
The object will move along its path and then jump back to the starting position.    It will then be 
ready for the player to select again.

Continuously
Once it starts moving it will keep on moving for ever.    Once it gets to the end of its path it will jump 
back and start again from its starting position.

Next action begins:
If the object is linked to another you can control when the link is activated

Immediately
The link will be activated immediately without waiting for this action to finish.

After this action stops
The link will not begin until this objects action has finished

When user presses key
The link will not begin until the player presses a key or mouse button.    The player will be given a 
message at the bottom of the screen asking them to press something to continue.

Sometimes objects can have two actions - for example a speech bubble can speak and have a movement
path.    Story Maker tries to be intelligent about when the action stops in these cases.    And if an object 
with a sound (or speech) is linked to another object with a sound or speech, the link cannot be followed 
until the sound of the first object is finished.    The 'next action' cannot begin 'immediately'.





 Make bubble narrower

Click on this button to make the speech bubble narrower in steps. The text in the speech bubble will be 
reformatted to the new width.    If necessary the bubble will be made taller so that it all fits.

You can also change the width of speech bubbles using the resizing bobbles that may appear at the 
corners of the box that is drawn around the selected object. You turn bobbles on or off by selecting Sizing 
bobbles in Preferences in the File menu. 



 Make bubble wider

Click on this button to make the speech bubble wider in steps. The text in the speech bubble will be 
reformatted to the new width.    If necessary the height of the bubble will be reduced so that the text fits in 
neatly.

You can also change the size of speech bubbles using the resizing bobbles that may appear at the 
corners of the box that is drawn around the selected object. You turn bobbles on or off by selecting Sizing 
bobbles in Preferences in the File menu.



 Edit text

Click on this button to put text into the bubble or change the text.    As you type or delete text the height of 
the bubble will change so that the text fits.    To change the width of the bubble use the narrower and wider
buttons, although it is often better to resize it after you have typed in all your text.

You can also start editing the text by double-clicking on the speech bubble or starting to type when the 
speech bubble is selected.



 Listen to speech

Click on this button to listen to the text in the speech bubble being read.    The voice used to read it is set 
using the Speech button.



 Speech bubble spike

The spike is the name we give to the part of the speech bubble that points to the character that is 
speaking.

For narrative text that is not spoken by any character you can turn the spike off using this button.    
Pressing the button again will turn it on again.

Note that you can reposition the spike around the outside of the speech bubble by dragging inside the 
spike.    You can also change the position of the end of the spike by dragging on the end bobble.



 Stop Editing

Click on this button to stop editing the text of your bubble.    You will now be able to reposition it on your 
page, listen to the speech or change the voices etc. 

You can also stop editing by clicking of the bubble on another part of the page.



 Smaller text

Click on this button to make all the text in your speech bubble smaller.    If you want to change the size 
significantly or change the font used then your should click on the change font button.



 Bigger text

Click on this button to make all the text in your speech bubble bigger.    If you want to change the size 
significantly or change the font used then your should click on the change font button.



 Change font

Click on this button to change the font used in your speech bubble.

You can change the typeface, size and style (bold, italic and underline).    Any change affects the whole of 
the text in the bubble.



 Text justification

Click on this button to justify the text in your speech bubble differently.

The text can be over to the left of the bubble, in the middle of the bubble, or over to the right of the 
bubble.    This button cycles through each justification in turn.    Any change affects the whole of the text in 
the bubble.



 Colour of letters

Click on this button to change the colour of all the letters in your speech bubble.

You are given a choice of the available colours.    Click on the one your want.    Any change affects the 
whole of the text in the bubble.



 Background colour of text

Click on this button to change the background colour of the text.    

You are given a choice of the available colours.    Click on the one you want.    The background colour of 
the whole bubble is set to the chosen colour.    Any change affects the whole of the text in the bubble.

You can also choose see-throughThis makes the background transparent.    This is useful if you want , for 
example to put words on top of objects - perhaps a name on the side of a van.    With see-through 
backgrounds the outline of the bubble is not drawn.



 Check

Click on Check to find the next mis-spelt word on your page. When the spell checker comes across any 
word in a speech bubble it does not know, it highlights the word and gives you a list of suggestions (or 
<none> if it has no suggestions to make).    Simply click on the word in the list which you want to replace 
the highlighted word (or select Ignore if you do not want the word changed).    If the correct spelling of the 
word is not in the suggestions list, you can just type (without quitting the spell checker) and replace the 
word in the speech bubble directly.

Check will go through each of your speech bubbles in turn.    If you want it to check a particular bubble 
select that bubble and then click on Check again.    However, this may mean that some bubbles are 
missed out, so to be sure of checking all the bubbles on the page, select Check spelling from the Edit 
menu again.

Story Maker comes with two dictionaries - a Beginner's (suitable for younger children) and an Advanced.   
You choose which to use with Dictionary in Preferences menu in the File menu.



 Ignore mis-spelling

Click on Ignore, when a word is highlighted to tell the spell checker that this is a valid word.    You might 
need to do this with names of people or places.

Story Maker will remember the ignored words for a particular story so will not ask you about that word 
again on any page.



 Stop spell checking

Click on Stop, when you don't want to look for any more mis-spellings on the page. 



 Suggestions

When the spell checker comes across a word it doesn't know it gives you a list of suggestions from it's 
own dictionary.    If it has no suggestions to make it will put <none> in the list.

To replace the mis-spelt word with one of the suggestions simply click on the suggested word.    If you 
know how the current word should be spelt, but the correct spelling is not included in the suggestion list, 
you can just type and replace the word directly.

If there are a lot of suggestions you may need to scroll through the list.

The number of suggestions given will depend upon which dictionary is being used. Story Maker comes 
with two dictionaries - a smaller Beginner's (suitable for younger children) and a larger Advanced.    You 
can choose which to use with Dictionary in Preferences menu in the File menu.



 New Story

Use this command to create a new story.    If you are already working on a story you will be asked if you 
want to keep that first.

You can open an existing story or story starter with the Open command.



 Open existing story

Use this command to open a previously written story and to make changes to it if you want.

Open also allows you to open a Starter story.    These are ideas for childrens stories, with the first page or 
two begun.

Normally you will want to open a story, so the Stories button is selected.    If you want to see the starters, 
choose the Starters button.    Note that Stories and Starters are stored in different directories - select the 
Full Store button to see which (and to open stories on other directories).

Starter stories give children a start in writing a story of their own.    There may just be a page or two of 
ideas, or a story line to get them going.    You can save starters of your own to add to the ones supplied 
(see Save).



Merge story

Use this command to join two stories together.    A story that you merge with your current one will be 
placed after the last page of your current story.

Note that you cannot merge a story with itself.



Save Story,      Save Story As

Use this command to keep your current story safe.    Note that if you wish to save your story as a starter, 
you will have to select the Starters option in the save panel.

The first time you keep your story you will be asked to give it a name.    From then on it will always use 
this name.    If you later want to keep the story with a different name or in a different place (such as with 
the starters) then you must use the Save As command from the file menu,



Print

Use this command to print the pages of your story. Note that printing always prints the pages exactly as 
they look when you are making your story - not when you are playing it (if there is any difference).    

This command will give you a dialogue box with a number of choices

The size of the print out is controlled by the Size button.    Sizes vary from 8 pages on one sheet of paper 
to 1 page on 4 sheets of paper.    Use Print Preview to see how the pages will print before committing 
them to paper.

You can choose to print all of your pages or just a selection of them, and you can also choose to have a 
number of copies.

The Print dialogue box will show you which printer the stories will be sent to.    To change this, select 
Printer setup from the file menu.

For more information on Printing Stories select the Printing Stories section.



Print Preview

Use this command to see exactly how your Story Maker pages will be printed on your printers sheets of 
paper.    You can zoom in and out to view in closer detail or have a more general picture.

When not zoomed in you can choose to view one or view two sheets of paper at a time.    Note that 
when viewing two sheets the Next and Previous buttons still only move you one sheet at a time.

When you have finished previewing click on the Close button to return to making your story.

Note that printing always prints the pages exactly as they look when you are making your story - not when
you are playing it (if there is any difference).



Choose print size

Use this command to choose the size of your printing.    Story Maker always tries to fill your paper, so 
what you are choosing is how many pages you want printed on a single sheet of paper, or how many 
sheets of paper to use for each page.

You can choose between the smallest size of 8 story pages printed per sheet of paper and the largest 
poster size of having each story page printed on 4 sheets of paper.    

The Print size dialogue box shows the various choices, click on the radio button next to the appropriate 
picture.    The picture also gives some indication of the orientation of the page on the paper (landscape or 
portrait).    Story Maker will override any change to the orientation you might make within the Printer 
Setup dialogue box.

The best way to see the effect of your print size choice is to use Print preview which displays the pages 
on the screen before you commit them to paper.



Printer Setup

Use this command to choose details about the printer and paper tray you are going to use etc.



Preferences

Preferences leads you to another menu that lets you configure various options about Story Maker.

Keep settings allows you to save the options as you have currently set them up for Story Maker.    You 
can choose to Keep them now; Keep them every time you leave Story Maker, or (if you make a mess of 
them!) revert to the settings that came with the program.    The settings include everything in the 
Preferences menu, plus your current settings of such things as the Font to use in your speech bubbles 
etc.    The settings are kept in a file called STORYM.INI

Advanced tools adds the Cut, Copy and Paste, and the Sound, Speech, Visibility and Actions 
buttons to the Making screen.

Dictionary: choose between the Beginner's and the Advanced dictionaries.    The Beginner's removes 
words that children commonly mis-spell (such as reed) from the dictionary, so that such mis-spellings will 
be spotted.

Recording speed affects the number of 'snapshots' that are taken of your object as you record a path.    
Recording Very fast takes lots of shots, and will give the best quality when you are playing and see the 
object move along the path.    But this may slow your computer down at times.

Resize stories to Window.    If you select this setting, then each page of your story will be either 
expanded or contracted to fit the window in which you are running Story Maker.    This may be useful if 
using a higher resolution screen setting, but may slow down the program and make the pictures look 
'bitty'.

When Story Maker resizes the story to fit the window it bases the enlargement upon the largest 
background picture in your story.    In this way the objects are scaled by the same amount on every page.  
If adding backgrounds you have drawn yourself it is best to make sure they are the same size as the ones
we supply.    See Extending the Backgrounds for more detail.

Sizing bobbles allows you to choose whether to have these on speech bubbles or on stamps and 
sprites.    You can always resize objects with the sizing buttons on the right-hand side of the screen even if
they have no sizing bobbles.

Note that speech bubbles can only be re-sized sideways.    To make a speech bubble deeper you must 
type (for example) carriage returns by pressing the Enter key on the keyboard.

Voices allows you to configure which number voice is used for the Man voice , which for the Woman and 
which for the Child.



Exit

Takes you out of Story Maker.    You are asked if you want to save any changes you have made to your 
story before it quits.



Undo

This command will undo your last change to the page (if it can).

You can undo most changes made to objects: size, position, paths recorded, text details in a speech 
bubble and changes made via the Sound, Speech, Visibility and Actions options.

In addition you can also undo a change to the background, the addition or deletion of an object (including 
using Cut and Paste) and changes using Move to front and Move to back.

The undo menu item will change to give you more information as to what it is going to undo.    For 
example Undo change background. If it is not possible to undo your last operation then the Undo 
command will be dimmed.

Once you have used Undo, the menu item changes to Redo in case you want to undo the undo.



Redo

This command undoes the last undo command, should you change your mind.



 Cut

This command deletes the currently selected object(s) or text from your page and places them on the 
Windows clipboard.

You can then Paste these back onto any page within your Story or into another Windows application.

See Cutting and Pasting for more information on using the Cut command.



 Copy

This command takes a copy of the currently selected object(s) or text from your page and places them on 
the Windows clipboard.

You can then Paste these back onto any page within your Story or into another Windows application.

See Cutting and Pasting for more information on using the Copy command.



 Paste

This command takes what is on the Windows clipboard and places it onto your Story page.    If the 
clipboard contains a picture, a new picture stamp will be created.    If the clipboard contains text then if 
you are editing a speech bubble the text will be inserted into that bubble, otherwise a new speech bubble 
will be created.    You can also paste sounds from the clipboard onto stamps or sprites.

See Cutting and Pasting for more information on using the Paste command.



Group as one

This command allows you to group several objects together.    For example, you might assemble a Roman
on a horse, with a cloak and a helmet.    If you then decide to move him elsewhere you need to move 
each bit.    You can select several objects by clicking on them one-by-one with the Shift or CTRL key held 
down, or by dragging a rectangle around all of them.    Then you could move all of them as one.    But it 
may be easier (after selecting them all) to Group them.    Then whenever you click on any part of the 
group, it will all be selected.    The group acts as a single object.    You can now record a path for it, 
change its size with the change size buttons - more or less anything you can do with a single object.

If the group (or multiple selection) is made up entirely of speech bubbles you will then be able to change 
details about the text such as font size and colours.

Note that if you do group objects (or select several) making changes such as when they are visible or 
invisible will change all of them.    If the separate objects had links going to or from them, they will lose all 
these links when they are grouped.    (If you just select several objects the links are not lost.)

To separate a grouped object    use Ungroup.

You can group together objects that have already been grouped.    The new object becomes a grouped 
object of grouped objects so ungrouping it later separates the objects back into their original groups, 
rather than back to individual objects.



Ungroup

This command separates a grouped stamp back into its separate parts.    See Group as one for more 
details about grouping stamps together.



Check spelling

This command will start checking the spelling on your current page. A new panel comes up on the right 
hand side of the screen.

Start checking by selecting the Check button.    When the spell checker comes across any word in a 
speech bubble it does not know (such as childrun), it highlights the word and gives you a list of 
suggestions (or <none> if it has no suggestions to make).    Simply click on the word in the list which you 
want to replace the highlighted word (or select Ignore if you do not want the word changed).    If the 
correct spelling of the word is not in the suggestions list, you can just type (without quitting the spell 
checker) and replace the word in the speech bubble directly.

Check will go through each of your speech bubbles in turn.    If you want it to check a particular bubble 
select that bubble and then click on Check again.    However, this may mean that some bubbles are 
missed out, so to be sure of checking all the bubbles on the page, select Check spelling from the Edit 
menu again.

If you want to stop before all the bubbles have been checked click on the Stop button

Story Maker comes with two dictionaries - a Beginner's (suitable for younger children) and an Advanced.   
You choose which to use with Dictionary in Preferences menu in the File menu.



Show names

This command allows you to see the names of stamps and sprites as you move your cursor over them.    
Each stamp and sprite has a name (though some names like Roman soldier come up rather a lot!).    
When making your story can insert a name into a speech bubble using Insert name, or change a name 
using Rename.

When making a story, Show names stops as soon as you click on something.



Speak names

This command will speak the names of stamps and sprites as your cursor passes over them. Each stamp 
and sprite has a name (though some names like Roman soldier come up rather a lot!).    When making 
your story can insert a name into a speech bubble using Insert name, or change a name using Rename. 

When making a story, Speak names stops as soon as you click on something.



Show links

This command shows all the links between objects on the page.    They are shown until you click on 
something.    You can also use the shortcut Ctrl L to see the links

When you have a lot of links on a page it can be difficult to remember how they link together, Show links 
will help you to work out how the chain of events will be followed.

Links to pages are shown by a picture of a page with a number beside it.



Playback speed

This command lets you change how quickly an object moves along its recorded path.    You might record 
the path slowly so you can follow a route accurately, and then play it back at a faster speed.      You can 
also use Playback speed to make it move slower.    There are five different speeds.

On slower computers setting a faster playback speed for an object might not have any effect, particularly 
if there are other objects moving as well.

To set the speed at which stamp movements are recorded use Recording speed in Preferences from the 
File menu.



Rename

All stamps and sprites come with names.    This command allows you to rename any stamp or sprite on 
your page to what you want.    So you can rename a dog in your story to be Pongo.    This could make 
your story more interesting for players, so it is undoubtedly a Good Thing.

To see the names of the stamps select Show names in the Stamps menu when making a story or click on
the button when playing a story.

Note that you will have to use Rename several times if you use the same character several times (or you 
could copy the re-named stamp and paste it - the new name is preserved).    If your character appears 
more than once on a single page you can use multiple selection to select all of them and then use 
Rename to rename them all.



Insert name

This command is only active when you are editing a speech bubble.    When you are doing so, selecting 
Insert name shows the names of objects as you move your cursor around the screen.    Clicking on an 
object will insert its name at the typing cursor in the speech bubble.

This is useful if you don't know how to spell the name of the object, or if an object has a very long name.



Remove sound

This command allows you to take off a sound from an object that has one, so if you drop your sound on 
the wrong object or change your mind you can make an object silent again.



Remove path

This command allows you to take off a path from an object that has one, so if you decide you don't want 
the object to move after all you can make it stand still.



Link to page

You use this command to make a link from an object to a page.    This means that when playing a story, 
you click on an object Story Maker will turn to a page and continue the story from there.

By use of this command you can create branching stories suitable for adventure books, or stories that 
proceed without user intervention.

When you select Link to page a box comes up with several options for your link.    You can link to a 
particular page number; the next or previous page of your story; restart the current page again or break 
the link.

When linking to a particular page number the page must already exist.    If you later delete that page then 
the link is broken.    If the page you have linked to changes its number (because you have inserted or 
deleted a page) then the link is changed so that it uses the new number.

As a shortcut you can click on the link button  followed by the next page 

 or previous page 

 buttons in the toolbar.    This will bring up the box with the options mentioned before.



 Previous page

This command moves you back to the previous page of your story. 



 Next page

This command moves you on to the next page of your story.    

When making a story, to the next page when you are already at the last page will create a new blank 
page.    If you want a blank page somewhere else or want to transfer all your objects onto your new page 
then use Insert Page to make a new page. 



First page

This command moves you to first page of your story. 



Last page

This command moves you to last page of your story.    



Go to page

This command asks you which page you want to move to and then moves you there.    Page numbers are
shown at the bottom of the screen.

    When playing your story you can also click on this button.



Insert page

This command allows you to insert a single page either before or after the one you are looking at.    You 
can insert blank page, or an exact copy of the page you are looking at (or any other page).    Inserting a 
copy of a page is useful if you have a story with lots of characters on each page.    Just copy your page 
onto the new one and delete the characters you don't want.    But be careful about which page your are 
deleting from - both your new page and the old one will look identical.    Check the page number at the 
bottom of the screen.

Clicking on the next page button when you are looking on the last page of your story will automatically 
insert a new blank page.



Delete page

This command gets rid of your current page and everything on it.    Use with care! 



Play page

This command lets you play your current page to see how your objects interact.    See Playing Stories for 
more information on playing.    Click on the Stop button to return to making.



Play story

This command takes you to page 1 and starts playing that page.    See Playing Stories for more 
information on playing. 



Stop playing story

This command takes you back to making stories.    All objects are returned to their original positions.    See
Playing Stories for more information on playing. 



Replay page

This command tells Story Maker to act as if you had just turned to the page.    All objects are returned 
back to their starting position.    This is particularly useful when testing your pages. 



Sound

This controls whether your computer whistles, beeps, barks and speaks to you when you are playing your
story, or whether you have a quiet life.    You cannot turn off the sound from within Story Maker when 
making stories.

The current setting of Sound is recorded when you keep the Story Maker Preferences.



Automatic page turning

This controls whether the pages are to be turned automatically by Story Maker rather than waiting for the
player to click on the next page button.

After a set period of inactivity (see Set turning speed) Story Maker will automatically turn to the next 
page.    Inactivity means no movement of the mouse or keyboard and no links waiting for an action to 
finish.    When the last page has been shown Story Maker starts again from page 1.

This will mainly be of use if you want to set your computer to show set pages which do not require any 
interaction with the player.    This could be notices or directions to people, or for reading Story Maker 
stories to younger children.



Set turning speed

This controls how long to wait between before automatically turning the page.    The time is entered in a 
whole number of seconds.    It only has any effect if Automatic page turning is selected.

The turning speed time is recorded when you keep the Story Maker Preferences. 



Index (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can jump to 
step-by-step instructions for using Story Maker and various types of reference information.    

Once you open Help, you can click the Contents button whenever you want to return to the opening 
screen.



Using Help

Use this command for instructions about using Help.



About Story Maker

Use this command to display the copyright notice and version number of your copy of Story Maker.    You 
will need the version number should you require support.



Open dialogue box

The following options allow you to specify which story to open:
Name

Type or select the name you want to open.
Drives

Select the drive where the Story Maker file that you want to open is. 
Directories

Select the directory where the Story Maker file that you want to open is.
Show

Choose between Story Maker stories and Story Maker starters.



Save As dialogue box

The following options allow you to specify the name and location of the story you're about to
save:
Name

Type a new name to save a Story Maker story with a different name.    Story Maker will
convert the name you enter into a Windows filename.

Drives
Select the drive in which you want to store the story.

Directories
Select the directory in which you want to store the story.

Type
Select the format to save the story in- use this to save the story in a format suitable for 
earlier versions of StoryMaker.

Save with
Choose to keep your story with the Story Maker stories or as a Story Maker starter.



Print dialog box

The following options allow you to specify how the story should be printed:
Printer

This is the active printer and printer connection.    Choose Printer Setup from the file 
menu to change the printer and printer connection.

Size
Lets you choose the size of the print out.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Title Bar

The title bar is located along the top of a window.    It contains the name of the application 
and document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside 
the scroll bars indicate your vertical and horizontal location in the document.    You can use 
the mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the Story Maker window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window.    Story Maker determines 
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window.    Story Maker 
determines which window is previous according to the order in which you opened the 
windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message.




